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Purpose

This toolkit is designed to assist staff in developing documents,
presentations, and events that are “accessible” and inclusive of people
living with disabilities. Throughout this guide are hyperlinks, some of which
include “how-to” videos for Google applications. The “how-to” videos are
less than 60 seconds. A “how to” video for Microsoft Office products is at

the end, under Other Considerations.

The Office of Health Equity

This toolkit is a publication of the Arizona Department of Health Services
(ADHS), Office of Health Equity. The mission of the Office of Health Equity
is to support and strengthen the internal capacity of ADHS to
operationalize health equity and to work with communities to reduce health

disparities.

Aligning with the Centers for Disease Control and Prevention’s (CDC)

Ten Essential Public Health Services, the Office of Health Equity develops
toolkits and training which actively promote “systems and services that
enable good health and seek to remove obstacles and systemic and
structural barriers.” This toolkit directly addresses the essential public

health service of enabling equitable access.


https://dro.dasa.ncsu.edu/what-does-accessible-mean/#:~:text=%E2%80%9CAccessible%E2%80%9D%20means%20a%20person%20with,substantially%20equivalent%20ease%20of%20use.
https://www.cdc.gov/publichealthgateway/publichealthservices/essentialhealthservices.html

Digital and Print Materials
Accessibility Checker

An accessibility checker can help you improve the accessibility of your

document. ADHS employees can download the approved accessibility

checker extension for Google Docs, Sheets, and Slides. Once installed,

you can use the accessibility checker feature in any Google Docs, Sheets,

or Slides.

All presentation materials should be available in advance and in
alternative formats such as Braille, large print (18 pt font size or larger;
Arial font), and in plain text. Plain text files are the most likely to be
accessible to all computer users who are blind or have low vision. PDFs
are not always accessible for people who are blind or have low vision.
And, although many people who are blind or have low vision use Google
docs or Microsoft Word, or have methods to convert PDF files, it is risky to

assume that everyone can open a Microsoft Word document or a PDF.

To create a plain text version of your material:
1. Go to the File menu.
2. Select Download.
3. Select Plain Text (.txt).
4. A plain text version of your document will download, which can then
be opened and saved. Send plain text documents in advance of a

meeting or event.


https://www.awesomescreenshot.com/video/6712644?key=62df74f4994d49957d0297097d70ca5c
https://www.awesomescreenshot.com/video/6712644?key=62df74f4994d49957d0297097d70ca5c
https://www.awesomescreenshot.com/video/6712984?key=76bc402d5e24fc79acdcba05aba417dd
https://telsupport.brookes.ac.uk/articles/how-can-i-create-a-plain-text-document/
https://www.awesomescreenshot.com/video/6716355?key=705086c4997daef1ab8f9bf7a5f3418e

Lists and headings enable people using a screen reader to understand

how the page is organized, and to quickly navigate to the content of

interest.

When listing items, explicitly create them as a list by using the list

features.

Headings and subheadings should be identified as such using the

built-in heading feature:

Heading 1 - Arial v - 14 + B

1 2 3 4

Insert a page break to avoid using the enter key multiple times.

1. Place your cursor where you’d like the current page to end.
2. Go to the Insert menu.

3. Select Break.

4. Select Page break.

Add Alt Text for pictures, logos, charts, or other graphics for people using
a screen reader. Only non-text elements conveying information must have

alternative text descriptions.

To add alt text:

1. Insert an image, drawing, or graphic in your document


https://www.afb.org/blindness-and-low-vision/using-technology/assistive-technology-products/screen-readers
https://www.awesomescreenshot.com/video/6713681?key=d10332dd0f6e24484b21d0869b2cb55a
https://www.awesomescreenshot.com/video/6713423?key=67a84fdc8e3e90bb557c14a37839da42

2. Right click on the image.

3. Select Alt text.

4. Type your title and a clear and concise description.
5. Click OK.

Alt text best practices:
e Do not write “image of” or “graphic of”".

o For example when describing an image, write “ADHS logo with red
squares and rectangles” instead of “This is an image of the ADHS
logo.”

e Provide the same content that is visually apparent.

e Keep your description brief.

Accessible PDFs:
e To edit a PDF: first, download it as a Word document to make your
changes and then convert it back into PDF format.
e When providing a PDF, you can:

o Convert it to plain text for individuals using screen readers. OR if
an accessible document or slide is created in Google, the
accessibility information is kept intact when converting it into a
PDF. Remember an accessible doc or slide must have the
following: headings, alt text, descriptive links, lists, large text in
black, and a document title. These “tag” the PDF, which provides a
hidden, structured representation of the content presented to
screen readers. Tags have no visible effect on the PDF.

e If you receive a PDF that is untagged, or where the tag structure is

incomplete or incorrect, it is best to return to the original Google or


https://www.awesomescreenshot.com/video/6803195?key=6cad616735acd7f7d3d2f8bb21e32008
https://webaim.org/techniques/acrobat/

Word document, make the necessary accessibility updates, then
re-create the PDF.

e You can also check your PDF for accessibility.

Below are a few best practices for digital and print materials:
O Text should be in sans serif fonts, like Helvetica, Veranda, or Arial,
size 16 or 18 (preferred) and in black.
0 Margins should be at 1 inch on all sides.
O Align all text to the left.
O Avoid underlining or italicizing.
O Spell out numbers (e.g., four, five, and six).
0 Use at least 1.5 spacing between lines in a paragraph.
O Use matte, cream-colored paper and print on one side only.
[0 Avoid using all capital letters, unless it is for an acronym.
O Enter one space after a period.
O Don’t use color coding as the only means of conveying information.
O Do not use a symbol such as $, %, or &, to replace text.
[J Provide clear color contrast between the text and background.

O Use the “Paste without formatting” option when pasting information to

avoid unknowingly adding formatting that is challenging for a person
who is using a screen reader.
O When working in Microsoft Word, make sure to save the Word

document in .DOCX format to ensure it is accessible.


https://www.awesomescreenshot.com/video/6803195?key=6cad616735acd7f7d3d2f8bb21e32008
https://www.awesomescreenshot.com/video/6713681?key=d10332dd0f6e24484b21d0869b2cb55a

Virtual Meetings and Webinars

Before hosting a meeting or webinar ask your attendees if any
accommodations are needed. Be sure to include how to submit an

accommodation request and a deadline to do so.

It is ideal to provide an American Sign Language (ASL) interpreter during
the meeting or webinar. For more information on ASL interpreters see the

Other Considerations section at the end of this toolkit.

If an interpreter is not available, the following is recommended:

e For events, Communication Access Realtime Translation (CART)

should be used. CART is a word-for-word speech-to-text service that
displays complete translation of all spoken words and environmental

sounds to communicate the integrity of the message.

e For a meeting, it's best to use Relay Conference Captioning (RCC).

RCC allows for deaf or hard of hearing participants to receive live,
real-time text during meetings. RCC must be requested at least 48

hours in advance.

Relay Conference Captioning Event Request Form

If RCC is not available, Google Meet has an automatic speech recognition
closed captioning feature. Closed captioning must be activated by the user

and is only viewable by that user.


https://www.acdhh.org/media/1616/cart-brochure_2017-current-2019.pdf
https://www.acdhh.org/media/1117/varizonarcc_brochure.pdf
https://www.tmobileaccess.com/arizona

To activate closed captioning during a Google Meet:

1. Open the meeting.

2. Click on CC at the bottom of your screen.

3. Once clicked it will turn light blue and the message “Captions have
been turned on” will briefly appear. You can click on the default
language listed in blue to change the closed captions language.

4. Captions will not be recorded.

Captions have been turned on English

4:13 PM | vhz-cajz-ioy

Google Meets does not always meet the accessibility needs of deaf, hard
of hearing, and DeafBlind communities. Zoom is the preferred platform for
use of ASL interpreters and streaming CART captioning services. Find
captioning instructions for Webex and Zoom under the Other

Considerations section at the end of this toolkit.

Users who have blindness or low vision can use the built-in screen reader,
full-page zoom, high-contrast color, and accessibility extensions in Chrome

Browser. Refer to the Google Meet accessibility page for more information.

Be aware that screen readers will also read the chat box, which can be
confusing for participants. Therefore, ask individuals to submit comments
and questions to a designated individual or co-host through chat. The
designated individual will read the questions or comments to the audience.

If you do choose to use the chat box, be sure to pause so people have


https://www.awesomescreenshot.com/video/6716474?key=7ea29b5cfbbc79057d93fd552f908168
https://support.google.com/meet/answer/7313544?hl=en&ref_topic=7306097

time to read what's in the chat. It is also helpful to put any links in the chat

and also read the chat for those who are on the phone.

Here are some additional tips:

0J Virtual events should be accessible via the internet and dial-in.

UJ If using Google Slides or other visuals in a meeting, be sure to
verbally describe any pictures, logos, charts, or other graphics. Also
read the text of the slide.

o For example, “We are on the title page of the presentation
Making your Document Accessible. The Arizona Department of
Health Services logo is included on this page. It has a number
of red rectangles and squares.”

J When moving to the next slide, announce it.

o For example, “We are now on slide two,” and continue with the
presentation.

[J Meetings should be no longer than 2 hours. For events, allow for a
5-10 minute break every hour.

LJ If you make a recording of the meeting available, the recording
should provide the ability to pause and restart at any time. If a
recording is made public, it should include accurate, grammatically

correct captions, ASL, and audio description/transcript.

Presentations (Google Slides)

Use one of the Google Slides default layouts to ensure your presentation
is structured for accessibility for those using a screen reader.

To use built in layouts:



https://adp.acb.org/ad.html#what
https://www.awesomescreenshot.com/video/7128645?key=cda606f0acea51d1ef434dbc686fa4df

1. Open an existing or blank presentation.

2. On the left side, above the slide deck, click on the plus sign for the
drop down menu.

3. Select one of the presentation layouts. See example of an

accessible slide below:

Welcome

Strategy updates

o Reduce opioid use and overdose fatalities

o Reduce suicide-related events

o Improve awareness and address the impact
of social isolation and loneliness on health

Start a Conversation - video

Moving forward and closing

' uuuuuu
§ OF HEA RVICES
Hrealth an ess for all Arizonan:

Be conscious of the order in which you create your slides. A screen reader
reads the elements of a slide in the order they were added to the slide, not

based on the position they are on the screen.

Always provide your slides in advance and in alternative formats; Braille,
large print (18 pt font size or larger), or plain text. When creating a
presentation for a meeting or for self-paced users:

e Do not use flickering, flashing, or animated text.

e Images, graphics or charts must have alt text.

o Use as little text as possible on each slide.

Additionally, display your presentation in Google Slides HTML. This
displays your presentation in a single, scrollable HTML page, instead of
one slide at a time. This is helpful to participants using screen readers.

To display a presentation in HTML view, open your slides and click on


https://www.awesomescreenshot.com/video/6716355?key=705086c4997daef1ab8f9bf7a5f3418e
https://www.awesomescreenshot.com/video/6713423?key=67a84fdc8e3e90bb557c14a37839da42

Ctrl + Alt + Shift + p.

Websites

Ensure the website is compatible with the range of assistive technologies
used by persons who have disabilities. These include but are not limited
to: screen readers, magnifiers, special keyboards, and alternative pointing

devices.

Web pages should use the same design principles as presentations. A
checklist is also available at the end of this toolkit.
Here is an example of a website with accessibility tools. Notice the widget

in the bottom right corner. This opens an accessibility tool menu for users.

Website Images
All images, grouped images, and non-text elements conveying
information must have alt text descriptions. Otherwise, people who use a

screen reader just hear "image."

Examples of items that require alt text:
e Charts
o Diagrams
e Graphs
e Logos
e Screenshots

e Pictures

10


https://www.neighborhoodvetclinic.com/
https://www.awesomescreenshot.com/video/6713423?key=67a84fdc8e3e90bb557c14a37839da42

Hyperlinks
When adding a hyperlink to a document or website, select the word or
words that refer to the hyperlinked material. Do not use “click here” or
“‘more information.” For example:

Try: The final report is now available.

Instead of: Click here for the final report.

To include a hyperlink:
1. Highlight the word(s) you want to hyperlink.
Go to the Insert menu.
Select Link.
Paste in your URL or link.
Click Apply.

o &~ Wb

In-person Meetings and Events

If planning an in-person event, visit the venue to determine if any barriers
to accessibility exist. Rather than asking if a venue is accessible, ask if the
venue has participated in an audit to determine its compliance with the
Americans for Disability Act (ADA). Also inquire if staff have been trained
in disability awareness and etiquette. For more detailed information you

can review the American Bar Association’s Planning Accessible Meetings

and Events Toolkit. Below are a few tips from the toolkit:

e During the registration process, ask participants if any accessibility
accommodations need to be made; include how to make a request
and by what date.

e Include a statement that the meeting or event is accessible in the

11


https://www.awesomescreenshot.com/video/6715352?key=266bb84d92805da1295dd8160d2acdf4
https://www.americanbar.org/content/dam/aba/administrative/commission-disability-rights/accessible-meetings-toolkit.pdf
https://www.americanbar.org/content/dam/aba/administrative/commission-disability-rights/accessible-meetings-toolkit.pdf

registration or promotional materials. For example, “We aim to host
events that enable individuals of all abilities to participate fully and
equally.”

Provide alternative registration options; online, telephone, text, or
email.

In-person participants may need a personal care attendant or
support service professional (SSP). Best practice, if allowable, is to
only charge the attendant for meals, not registration fees.
Designate staff to handle accommodation and accessibility requests
Doors should be propped open at the start and end of each session.
Multiple sets of power outlets for laptops and other electronics
devices should be available.

Tables for materials and food/beverage should be at a height (28 to
34 inches) reachable by mobility device users and in an accessible
location.

Provide space for service animals and a designated service animal
relief area with signage. Signs, also translated in braille, are
important for those with a vision disability.

Video screens should have closed-captioning when a person is
speaking.

Speakers should use a microphone and face the audience directly,

maintaining a clear view of the speaker’s mouth.

12



Other Considerations and Formats

Plain Language

Plain Language is writing to ensure any reader understands the concepts
quickly and easily the first time they read it. Whether the topic is simple or
complex, plain language ensures the general public can read and
understand what is written.

Below are a few tips from the Plain Language Checklist:

e Use words with three syllables or less.

e Use short sentences.

e Focus on need to know versus nice to know.
e Speak to the reader - use “you” and “we.”

e Use list format or bullet points.

When your material is easy to understand, it reaches a broader audience.

Many best selling authors write at a 4th to 6th grade level.

You can check your material for its reading level by using a free Automatic
Readability Checker.

Easy Read is recommended when the reader has intellectual or cognitive
disabilities. Easy read:

e |Is clear and easy to understand.

e Has a picture for every idea.

e Uses no acronyms.

e Includes large space between paragraphs.

e Has fewer ideas on a page.

13


https://e8v3d4a2.stackpathcdn.com/wp-content/uploads/2019/08/Plain-Language-Checklist.pdf
https://3v9p073zptntqyvo83pwbx1h-wpengine.netdna-ssl.com/wp-content/uploads/2015/01/shan3.jpg
https://readabilityformulas.com/free-readability-formula-tests.php
https://readabilityformulas.com/free-readability-formula-tests.php

Uses icons often as metaphors.

@' This icon would be a metaphor for women’s health.

Google Forms and Surveys

Google forms are generally accessible and can be completed using a

screen reader or by a sighted person on a keyboard. It is important to

follow the accessibility guidelines mentioned previously regarding

print/digital materials, images, and plain language.

Accessible forms and surveys are designed to be accessible to people with

a diverse range of hearing, movement, sight, and cognitive abilities. When

developing a quiz, survey, or form for on-line use, follow these tips to

ensure your survey or form is accessible:

Clearly state what the survey is about.

State how many questions there are or use a progress indicator.
Allow people to save and return to the survey, especially if it's long.
Utilize multiple choice or true/false questions.

o Using other formats, like drag and drop or fill in the blank, can
be difficult for individuals with limited mobility who use arrow or
tab keys.

Categorize sections by topic to organize content.

Use bulleted lists to break up text.

Make sure readers can use the tab key to move between questions
and between answers, as with any accessible form. Not everyone
can use a mouse.

If possible, include ASL video recordings of each question. Google

14



Forms and Survey Monkey allow videos to be added into the survey

above each question.

When creating questions:

Use words rather than numbers to rank items on a scale. For
example, strongly agree, agree, neutral versus rate this service on a
scale of 1-5. Words used for ranking must follow plain text guidelines.
When using buttons and boxes, decide how many response options
people can select. If only one, use radio buttons. If more than one,
use checkboxes.

Avoid posing questions in the negative so that the reader has to
answer “yes” to confirm a negative. It's confusing.

Rather than formatting questions in tables, separate out the
questions. Have readers answer each question individually.
Explanatory images with a question can also be helpful.

Here are some sample question formats.

Meals and Social Functions

It's important to ensure meals and other social functions are accessible to

persons who have disabilities. This includes sufficient room for everyone to

maneuver safely and independently, multiple meal options (vegan,

gluten-free, etc.), avoiding self-serve or buffet meals and allowing those

who have disabilities to enter first.

Always inform event guests of the accessibility features and

accommodations being offered. Share this information orally and in writing.

If using staff or volunteers during the event, appoint a “point person” for

15


https://www.ucop.edu/electronic-accessibility/web-developers/tools-and-testing/guidelines-accessible-surveys-forms.html

accessibility issues and questions. Train volunteers and staff on use of

assistive devices and emergency procedures.

Captioning for Webex and Zoom
ADHS has Webex For Government which does not support captioning,

refer to this guide for general Webex meetings.

Zoom is the preferred platform when using ASL interpreters and streaming
captions. It is the most customizable and complex out of all the platforms,
however both the host and the participants may enable the accessibility

tools.

To enable Zoom captioning:

1. Click the up arrow next to the microphone icon (bottom left corner).

2. Select audio settings.

3. At the end of the left column, select accessibility.

4. Turn on captions.

5. If needed, adjust the size of the captions and utilize any other
settings.

Microsoft Office “how to” video

A short (3 minute) how to video covers the following:
e Accessibility checker

Plain text

Paste without formatting

Page break

Adding alternative text

Hyperlinks

16


https://help.webex.com/en-us/article/WBX47352/How-Do-I-Enable-Closed-Captions?
https://support.zoom.us/hc/en-us/articles/207279736-Managing-closed-captioning-and-live-transcription
https://www.awesomescreenshot.com/video/6749297?key=bb44c3458ac09e991cbcfb0e4b858346

Inclusive Documents and Meetings Job Aid

J Text should be in sans serif fonts, like Helvetica, Veranda, or Arial,
size 16 or 18 (preferred) and in black.

O Margins should be at 1 inch on all sides.

O Align all text to the left.

0 Avoid underlining or italicizing.

O Spell out numbers (e.g., four, five, and six).

[0 Use at least 1.5 spacing between lines in a paragraph.

O Use matte, cream-colored paper and print on one side only.

O Avoid using all capital letters, unless it is for an acronym.

O Enter one space after a period.

O Don’t use color coding as the only means of conveying information.

O Do not use a symbol such as $, %, or &, to replace text.

O Use the “Paste without formatting” option when pasting information to
avoid unknowingly adding formatting that is challenging for a person
using a screen reader.

O When working in Microsoft Word, make sure to save the Word
document as in .DOCX format to ensure it is accessible.

O To edit a PDF: first, download it as a Word document to make your
changes and then convert it into PDF format.

[J Virtual events should be accessible via the internet and dial-in.

UJ If using Google Slides or other visuals in a meeting, be sure to
verbally describe any pictures, logos, charts, or other graphics.

For example, “We are on the title page of the presentation Making
your Document Accessible. The Arizona Department of Health

Services logo is included on this page. It has a number of red

17



rectangles and squares.”
J When moving to the next slide, announce it.
o For example, “We are now on slide two,” and continue with the
presentation.
[J Meetings should be no longer than 2 hours. For events, allow for a
5-10 minute break every hour.
UJ If you make a recording of the meeting available, the recording

should provide the ability to pause and restart at any time.

For more detailed information and extensive checklists, you can review the
American Bar Association’s Planning Accessible Meetings and Events
Toolkit.
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https://www.americanbar.org/content/dam/aba/administrative/commission-disability-rights/accessible-meetings-toolkit.pdf
https://www.americanbar.org/content/dam/aba/administrative/commission-disability-rights/accessible-meetings-toolkit.pdf

